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Introduction

Design goals

The design goals of Weather Designer are to:

▪ Create a new broadcast production tool
▪ Develop a successor of TeleVis Weather
▪ Provide a powerful information visualization tool in a day-to-day operational production for

meteorologists, graphic artists, presenters and technicians
▪ Enable “non-weather” productions
▪ Access standard databases
▪ Support distributed environments

With this document we want to give you a comprehensive introduction to Weather Designer. In
addition to this, we want to encourage you to try some commands and examples. This is for many
users the quickest way to get familiar with the new program.
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First steps

Launch program

Double-click the Weather Designer icon on the desktop. The “New“ dialog box appears:

Choose a DesignModel from the dropdown menu (if applicable). The next steps depend on whether
you wish to create a new document or open a Template document.

Create a new document

▪ the radio button is already set to “Empty document” (default)
▪ select initial layer type (by default: Geo)
▪ select screen size (by default: 1920 x 1080 px)
▪ tick the box “Import animated image sequences of DesignModel” if you wish
▪ Press OK.

Open a Template document

▪ Tick the radio button on “Template document”
▪ Select the folder in which your template document (in the left panel, if applicable)
▪ Select the template document you wish to open (in the right panel)
▪ Press OK.
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Starting a new document by using the “New” dialog box leads automatically to “Save as…” when
you save for the first time. This prevents the unwanted overwriting of a template document.
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DesignModels
A DesignModel is a directory that contains

▪ Dedicated directories for different types of resources used by the Chyron Weather
▪ XML configuration files

You can prepare Template documents with the settings and basic pieces of content you wish. Then
place these documents in the “TemplateDocs” directory of the DesignModel. They will be listed in the
lower part of the “New” dialog box and you may open them from there.

Create Subscenes and save them in the subscenes folder. They are broken down documents
containing only one layer and can be reused either in Weather Designer or in Weather Presenter.
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Graphical User Interface
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Menu bar

“File” menu
▪ New... (Ctrl+n) to open a new document using the New dialog
▪ Open... (Ctrl+o) to open an existing document using the Open dialog
▪ Open Subscene... (Ctrl+u) to open a subscene in order to modify it. Subscenes are special

Weather Designer documents (file extension is ssc instead of dvz) that you can import into a
document using the command File>Import External Subscene

▪ Save (Ctrl+s) to save the document that you are currently working on. If you use the Save
command on a new document for the first time, the Save as... dialog appears automatically,
otherwise the document is saved without change of its name, directory or file type.

▪ Save as... (Ctrl+Shift+S) to save a document or a subscene when you want to change the
document name and/or its directory. The Save as... dialog appears where you can enter a file
name, choose a directory and change the file type.

▪ Save as Subscene... to save a document as subscene or a subscene when you want to
change name and/or directory.

▪ Refresh (F5) to update the content of the scene with new database content or modified
resource files such as bitmaps etc.

▪ Reconnect to the ODBC connection after a timeout of the database
▪ Import Image... to insert a bitmap graphic onto the selected layer. The default directory in the

Open dialog is Images of the design model in use. The supported formats are listed in the
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dropdown menu File type. Weather Designer only creates a reference to the imported bitmap.
If you modify it outside Weather Designer, you will see the modification in the Weather
Designer document after using Refresh (F5). The dialog also shows a preview, the dimensions
and the file size of the image.

▪ Import Image Sequence... to insert an animated bitmap sequence onto the selected layer. In
the dialog Find Directory you can select the directory where the image files are located.

▪ Import Video... to insert a video file onto the selected layer. In the Open dialog you can select
a video file (.avi) and watch a preview of the video clip using the slider. The dimensions of the
video images and the file size are displayed beside the image.

▪ Import 3DS Object... to insert a ready-made object of a 3D application in the 3D studio file
format including textures.

▪ Import ESRI Shapefile... to insert a shapefile (.shp). Shapefiles contain data that represent
geographic features such as rivers, lakes, roads, coastlines etc.

▪ Import External Subscene... to insert a Subscene predesigned in Weather Designer and
saved as Subscene with the command File>Save as Subscene...

▪ Import Custom Object... to insert a Weather Designer object previously designed in Weather
Designer and saved with the command Export Selected object... in an XML file.

▪ Export Selected Object... to save an object, a group of objects or a subscene for reuse. This
function enables you to reuse complex groups of objects, layers or subscenes. You can insert
these objects using the command Import Custom Object....

▪ Save selected Object as Template to store the settings for the selected object (i.e. size,
color, font) as default values for this object type

▪ Export selected Layer as Subscene... exports the selected layer as a subscene
▪ Export Shapefile... to export a scalar field as ESRI shapefile
▪ Export Projector... to export the projector of a Geo Layer or Geo Container
▪ Render Now... to have the document rendered according to the settings in the property page

Rendering of the scene object inspector.
▪ Submit Local Render Process... to have the document rendered by the optional Weather

Designer Server. If you use this function to render your document, Weather Designer Author
will not be blocked during the rendering process (background rendering).

▪ Submit Remote Render Process... to have the document rendered by the optional Weather
Render Manager software.

▪ Render Animation... submenu to either select a movie file format or an animation format for
saving the document as movie or as image series.

▪ Render Frame... submenu to select a bitmap format for saving the currently selected frame.
▪ 1 -4 xxxx.dvz to open one of the four latest files you were working on.
▪ Exit to leave the program. If you modified the file after you saved it, you are queried whether

you want to save the file before leaving the program.

“Playback” menu
▪ Play (Ctrl+Space) to play an animation (equivalent to the function of the play/stop button on

the animation toolbar).
▪ Stop (Ctrl+Space) to stop a running animation (equivalent to the function of the play/stop

button on the animation toolbar). The Stop command can most easily be executed with the
keyboard short-cut Alt+s.

9



▪ Previous Frame (Alt+Left) to step one frame position back from the current frame position
(equivalent to the function of the backward button on the animation toolbar). As long as the
animation is running, this menu item and its short-cut are inactive.

▪ Next Frame (Alt+Right) to step one frame position forward from the current frame position
(equivalent to the function of the forward button on the animation toolbar). As long as the
animation is running, this menu item and its short-cut are inactive.

▪ First Frame (Alt+Home) to go to the first frame (equivalent to the function of the first frame
button on the animation toolbar). As long as the animation is running, this menu item and its
short-cut are inactive.

▪ Last Frame (Alt+End) to go to the last frame (equivalent to the function of the last frame
button on the animation toolbar). As long as the animation is running, this menu item and its
short-cut are inactive.

▪ Loop to switch on or off the loop mode of the playback function, that is, if this menu item is
checked, the animation will run in a loop until it is stopped with Alt+S.

▪ Force Time-True to switch on or off the time-true mode of the playback function, that is, if
this menu item is checked, Weather Designer forces the playback function to preserve the
specified total animation duration. This is done by leaving out some frames of the scene (if
necessary), which may result in a jerky animation. Of course, this affects only the realtime
animation preview, not the quality of the rendered video or image sequence.

▪ Next Bookmark (F2) to jump with the frame indicator to the next bookmark on the timeline.
▪ Previous Bookmark (Shift F2) to jump with the frame indicator to the previous bookmark on

the timeline.
▪ Toggle Bookmark (Ctrl F2) to create a bookmark if the frame indicator does not sit on a

bookmark position or delete a bookmark if the frame indicator sits on a bookmark position.
This function is equivalent to doubleclicking the timeline.

▪ Clear all Bookmarks (Ctrl Shift F2) to remove all bookmarks from the timeline.
▪ Next Sync-mark (F3) to jump with the frame indicator to the next sync-mark on the timeline
▪ Previous Sync-mark (Shift+F3) to jump with the frame indicator to the previous sync-mark

on the timeline
▪ Toggle Sync-mark (Ctrl+F3) to create a sync-mark or delete a sync-mark if the frame

indicator sits on a sync-mark position. This function is equivalent to Alt+doubleclicking the
timeline. Sync-marks are used to sync an animation to different segments in Weather
Presenter.

▪ Clear all Sync-marks (Ctrl Shift F3) to remove all sync-marks from the timeline

“New Object” menu
▪ Layer to insert a new perspective layer in the scenegraph. Objects on perspective layers are

presented with their vanishing lines converging. A new layer is always inserted at the bottom
of the layer stack. The position of a layer in the layer stack determines the visibility of the
objects of this layer. You can change the position of a layer in the stack by dragging the layer
to the required position.

▪ Ortho Layer to insert a new orthographic layer in the scenegraph. Objects on orthographic
layers, in contrast to objects on perspective layers, are presented with their vanishing lines in
parallel.
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▪ Geo Layer to insert a new geo layer in the scenegraph. A geo layer is a orthographic layer,
where geo objects can be added. The object inspector of the geo layer allows you to select a
geographical reference shape, set the desired projection and adjust it to a background map.

▪ Primitives submenu to select a simple geometric object such as Point, Line etc. for insertion
on the layer or group that is currently selected in the scenegraph.

▪ 2D Text Object to insert a text field that can be transformed only in two dimensions on a
plane in parallel to the projection plane of the front or render viewport.

▪ 3D Text Object to insert a text field that can be transformed (moved and rotated) in three
dimensions.

▪ Text Column to insert a text column to use continous text with more than one line. It also
supports ligatures.

▪ Face Set to insert an initial primitive 3D object on the selected layer. You can replace this
initial object by a 3Ds file (3D studio format) from a 3D application by specifying the file name
and directory in the object inspector on the page General.

▪ Arrow to insert an arrow object into the selected layer.
▪ Front to insert a weather front object with its standardized appearance (curve with spikes or

half circles). In the object inspector, you can specify the type of front (cold or warm) the
orientation (inwards or outwards) and other features. The front object is a spline curve whose
shape can be changed by moving its vertices with the mouse if the button Vertex in the
Mouse Control toolbar is pressed.

▪ Group to insert a group object, which is a container for other objects. You can use a group to
transform and animate all the objects of the group collectively.

▪ Multiplier to insert a multiplier object, which is a container with special features for objects.
In the object inspector of the multiplier object, you can specify how often the objects in the
multiplier are to be repeated (Array page) and e. g. their x-, y- and z-offset to one another
(General page).

▪ Background to insert a background object on the selected layer. In the object inspector of
the background object, you can specify the features of the background. Normally, you will
define a texture resource (a bitmap file) as background.

▪ Blur Pane to insert a polygon that blurs everything behind it. Define the shape with vertex
points and specify the radius and quality of the blur effect

▪ Web Rectangle to insert a rectangle to show web content on. Define the web page to display
and wether that should be adjustable in Weather Presenter.

▪ External Subscene to insert an initial default subscene. You can replace this default
subscene by a subscene you have previously saved with the command File>Save as
Subscene... (see page 1-8). Use the object inspector (page General) to specify the file name
and directory where the desired subscene is located.

▪ External Flash Movie to insert a flash movie (swf) and define parameters used in the flash file
▪ Meteo Objects submenu to select a Weather Symbol, a Wind Arrow, a 2D Meteo Text, 3D

Meteo Text or a Meteo Text Column for insertion on the layer that is currently selected in the
scenegraph. Meteo objects can be connected to weather report and forecast data in order to
change their appearance and/or their text string according to the underlying data. In the
object inspector of the meteo object (Meteo Value page), you can specify the source and type
of meteo data to be visualized.
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▪ Geo Container to insert a container for geo objects (see next list item). The object inspector
of the geo container allows you to select a geographical reference shape, set the desired
projection and adjust it to a background map. Geo objects inside the geo container are then
positioned correctly with regards to the background map.

▪ Geo Objects submenu to select a Scalar field, Geo Image, Geo Background, Geo Group,
Geo Collection, Geo Multiplier, different kinds of ESRI shapes, a Geo Arrow, Geo Front,
Forecast Clouds and Lightning Bolts for insertion into a geo container. Geo objects contain
geographical references that allow their correct location on a map.

▪ Pie Chart to insert a pie chart object on the layer currently selected in the scenegraph. In the
object inspector of the pie chart object (Data page), you can specify the source and type of
data to be visualized.

▪ Chart Container to insert a container for chart objects (see next list item). The chart
container allows you to preconfigure the appearance and size of a bar chart or a line. You can
insert axes with labels matching the values specified in the Axes page of the chart container’s
object inspector.

▪ Chart Objects submenu to select a Bar Chart, Line Chart, Object Chart, Chart Axis X, Chart
Axis Y and Chart Axis Z for insertion into a chart container.

▪ Directional Light to insert a light source with a position indefinitely far away from the scene.
For Directional Light you can specify a direction and colors for the light components ambient,
diffuse and specular.

▪ Positional Light to insert a light source for which you can additionally specify the position of
the light source.

▪ Grid to insert a 3D grid object which is a rectangle with grid lines for orientation purposes (not
rendered). The 3D grid object can be positioned and orientated in space like other 3D
objects. The object inspector allows you to define the number and the width of the grid cells.

▪ 2D Grid to insert a 2D grid object. In contrast to the 3D grid, the 2D grid object can only be
moved and rotated on an x-y plane. If you move the 2D grid object in z-direction, it does not
change its size, even if it is placed on a perspective layer.

“Edit” menu
▪ Undo (Ctrl+z) to cancel previous actions (default: 30 actions backwards. See also section

Weather Designer initialization (.ini) files). You can undo everything that changes the content
of the document (e.g. object properties) but not actions such as zoom factor, view modes and
navigation through the animation that affect merely the display of the scene.

▪ Redo (Ctrl+y) to cancel previous Undo actions. This menu item is only active if the last
command was Undo. You can cancel all previous Undo actions that were executed in a row.

▪ Cut (Ctrl+x) to move a selected object onto the clipboard. You can select the object in the
viewport or in the scenegraph. This menu item is only active if an object is selected.

▪ Copy (Ctrl+c) to copy a selected object onto the clipboard.
▪ Paste (Ctrl+v) to copy an object from the clipboard onto the selected layer, into the selected

group or into the selected container object (e.g. geo container).
▪ Delete (Del) to delete a selected object.
▪ Move up (Ctrl+Up) to move a selected object by one position up in the object stack of the

layer, the group or the container object. You can also move whole layers in the layer stack of
the scenegraph. The position of the object in the respective stack affects its visibility in the
viewport only if the option Layering mode is selected in the layer’s General page. Otherwise
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the visibility of an object depends on its position in space, that means in the Render View it
depends on its z-coordinate.

▪ Move down (Ctrl+Dwn) to move a selected layer or object by one position down in the layer
stack of the scene, in the object stack of the layer, in the group or in the container object.

▪ Insert Time Segment to insert a time segment at the current animation time and shift all
keyframes accordingly.

▪ Stretch Time Segment to stretch a time segment at the current animation time and adjust all
keyframes accordingly.

▪ Delete all standard keyframes to delete all standard keyframes, i.e. for fading and
transformation. This operation can also be performed on multiple selected objects.

▪ Adjust Object to screen to move an object to the centre of the screen and adjust its scale
factors so that it fits into the viewport. If the object is not visible in the viewport, you can still
select it in the scenegraph and use Edit>Adjust Object to screen.

▪ Resolve Text Object to resolve a text object into its single characters in order to animate the
characters separately or to change their properties separately.

▪ Add to Task... to add an object to an existing task or create a new one

“Viewport” menu
▪ Zoom in or out on the viewport, that is, the higher the value the larger the viewport becomes.
▪ Views (the selected view mode is marked by a dot left of the menu item):

o Render View (Ctrl+0) to set the selected viewport to Render view. This view shows
the scene through the camera as it will be rendered. Additionally it displays two
safeframes (yellow and green) which represent the safely displayed area of video
display devices.

o Perspective View (Ctrl+1) to set the Perspective View for the selected viewport. This
view shows the scene from the outside (camera together with the scene). In this view
and all following views the camera can be moved with the mouse if Mouse controls is
set to Camera.

o Left View (Ctrl+2) to set the selected viewport to Left view. The scene is displayed
from the left together with the camera.

o Right View (Ctrl+3) to set the selected viewport to Right View. The scene is displayed
from the right together with the camera.

o Front View (Ctrl+4) to set the selected viewport to Front View. The scene is displayed
from the front together with the camera.

o BackView (Ctrl+5) to set the selected viewport to Back View. The scene is displayed
from the back together with the camera.

o Top View (Ctrl+6) to set the selected viewport to Top View. The scene is displayed
from the top together with the camera.

o Bottom View (Ctrl+7) to set the selected viewport to BottomView. The scene is
displayed from the bottom together with the camera.

o Next View (PgUp) to cycle through the views from the currently selected view
downwards and back for the selected viewport.

o Previous View (PgDwn) to cycle through the views from the currently select view
upwards and back for the selected viewport.

o Reset Current View to shift the selected view in such a way that the camera volume
of the selected layer is fully visible.
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o Reset All Views to shift all the views in such a way that the camera volume of the
selected layer is fully visible.

o Multiple Viewports (Ctrl+M) to switch on or off the display of four viewports at a time
instead of a single viewport.

“View” menu
▪ Toolbar to switch on and off the display of the tool bar, which is by default docked on

underneath the menu, but you can drag it away and drop it somewhere else.
▪ Viewport Bar to switch on and off the display of the viewport bar, which is by default docked

on underneath the menu on the right side of the tool bar, but you can drag it away and drop it
somewhere else.

▪ Message Log to switch on or off the display of the Message Log window, which displays the
program and system messages. If the Message Log is docked, selecting this menu item will
bring the message tab to the foreground.

▪ Geo Browser to switch on and off the display of the geo browser, which is a dialog for
selecting and setting weather stations and the respective positioning of geo objects.

▪ Alpha Modulation Editor to switch on or off the Alpha Modulation Editor.
▪ Status Bar to switch on and off the display of the status bar which is at the bottom of the

user interface on the lefthand side. The status bar displays short explanations about menu
commands, tool bar icons and other user interface elements.

“Extras” menu
▪ Create New Design Model... to open the dialog New Design Model.
▪ Adjust Design Model... to open the dialog Resource Directories.
▪ General Settings... to open the dialog General Settings. Modifications and definitions in this

dialog affect all design models.
▪ Determine Codec Code to open a dialog where you can select a video compressing mode

(codec) for which you want to find out the code. If you want to select the code for rendering,
it is easier to doubleclick the code field in the field Codec in the page Rendering of the Scene
object inspector.

▪ Licensing Info to open the Chyron Weather licensing dialog. Check your installed licenses
here.

“Options” menu
▪ Document Directory... to open a dialog where you can select the directory where your

documents are opened and saved by default.
▪ Weather Render Manager Directory to specify the watch folder for the Weather Render

Manager.
▪ Auto Save... to switch on or off the Auto save function (default: on). The document will be

saved every three minutes if the function is switched on and changes have been made in the
document. You can adjust the time between autosaves in the WeatherDesignerAuthor.ini file.
If you restart Weather Designer after a program crash, you will be asked whether you want to
reload the latest Auto Save document.

▪ Message Boxes to switch on or off the display of the following functions in connection with
message boxes: Auto Retry - if this function is on, message boxes with the query Retry? are
not shown and the Retry command is automatically confirmed once.
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o Auto Confirm GUI Messages - if this function is on, message boxes with a Weather
Designer GUI message are not shown and the OK command is confirmed
automatically. In addition, a balloon message (hint) appears above the Weather
Designer icon in the system tray (normally at the lower edge of the desktop).

o Auto Confirm Warnings - if this function is on, message boxes with a warning are not
shown and the OK command is confirmed automatically. The display of the messages
in the message log window is not affected by the above settings.

▪ Auto Layout Window Panes This function is switched on by default. If activated the docked
window panes will be automatically resized at startup of Weather Designer.

▪ Multithreaded rendering This function is switched on by default. It makes the rendering
faster because the various subprocesses of the rendering are run in parallel if possible. In rare
cases this can cause problems. For this reason you can switch off the function.

▪ Scale Timelines to fit If this option is selected, the timeline comprises the whole animation
regardless of its total duration, otherwise a horizontal scollbar is provided for animations with
a duration of more than 10 seconds.

▪ Show Grids to switch on or off the display of grid objects if there are any.
▪ Show Safeframe to switch on or off the display of the safeframes in the render view.
▪ Show value type icons to switch on or off the value type icons within the selection frame of

meteo objects.
▪ Show Object Translation Path to switch on or off the display of the translation path. This

function is only effective if the object is selected and has at least two translation keyframes.
▪ Show Vertex Translation Path to switch on or off the display of the path of animated

vertices. This function is only effective if there are at least two keyframes. At keyframe
positions the outline of the corresponding object (front, polygon, etc.) will be shown.

▪ Show Vertices of all objects to switch on or off the display of vertices of objects that are not
selected (only effective if Vertex is selected in the viewport bar).

▪ Show bounding boxes within subscenes to switch on or off bounding boxes for objects in
subscenes

▪ Snap Vertices to switch on or off the snapping of vertices. This option allows you to attach
vertices to one another (also linking different objects) and thereby create complex frontal
systems.

▪ Update Videoframes to switch on or off the update of the single frames of imported videos
while playing a scene with the playback function.

▪ Expert Data Wizard to switch on or off the initial mode of the Data Wizard. If this option is
switched on, the Expert Data Wizard appears instead of the Easy DB Wizard when you select
the option databased for objects that can have a connection to a database (e.g. chart
objects, scalar fields).

▪ XML Editing to switch on or off the user editing mode of the XML page for all objects.
▪ Store Data Modifications For Undo to switch on or off the saving undo/redo information

when manipulating data sets. Deactivating this option conserves system memory when
editing large Grib data sets. The settings of the menu Options are user-specific, that is,
modifications are permanently effective only for the current user.
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Viewports

A viewport is a projection plane on which the objects of your scene and the camera are displayed
depending on the settings in the viewport menu and on the viewport bar.

You can either display a single viewport or four viewports. The visible area depends on the selected
zoom factor and the size of the window pane. Each viewport can display a different view of the
scene.

Objects are either displayed in perspective view or in orthographic view depending on whether they
are placed on a perspective or an orthographic layer. What you can control with the mouse you
determine with the buttons on the viewport bar.

By default the viewport bar is docked on to the title bar underneath the menu.

There are the following options:

▪ Zoom: This combo box allows you to select or type in a zoom factor for the viewport.
▪ View: In this mode you can change with the mouse the position, the distance and the

orientation of an observation point outside of camera and objects as a whole. That gives you
different perspective views of the scene without changing the relative position and orientation
of camera and objects. For this reason, the render view is not affected by manipulations in
this mode.

▪ Camera: In all views but the Render View you can change the position, the apex angle and
the orientation of the camera. In Render View you cannot manipulate the camera but the view
of the object changes if you change the relative position and orientation of object and camera
in one of the other views.

▪ Sample: This setting enables you to place labels for data samples on a scalar field (e.g.
temperature, pressure) by clicking with the left mouse button on the desired location while
holding down the Shift key.

▪ Data: This setting enables you to manipulate the data of scalar fields with the mouse by
clicking with the mouse on the location where you want to increase (left mouse
button)/decrease (right mouse button) the values.

▪ Vertex: This setting enables you to select, create, delete and move vertices of curve-like
objects such as front, line and polygon objects. Vertices in the Weather Designer context are
points were the segments of lines, polygons or curves meet. Vertices allow you to change the
shape of curves or the outline of polygons.

▪ Object: This setting allows you to select, move, rotate and scale objects in the viewport (all
views) with the mouse.

▪ Texture 1, 2 or 3: This setting enables you to select, move, rotate and scale textures relative
to the objects they belong to in the viewport (all views) with the mouse. The indices 1 - 3
correspond with the texture stages that can be created in an objects property page Textures.

▪ Lock Texture Stages: If this option is selected, mouse manipulations of the texture stages
affect all texture stages at once, no matter which Texture button is selected.
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Toolbar

The tool bar offers you short-cuts to some functions that are needed more frequently such as:

● New icon, to create a new document. Equivalent to File>New... or Ctrl+n

● Open icon, to open an existing document. Equivalent to File>Open...or Ctrl+o

● Save icon, to save the currently open document. Equivalent to File>Save or Ctrl+s

● Cut icon, to move the currently selected object, group, layer or text to the clipboard.
Equivalent to Edit>Cut or Ctrl+x.

● Copy icon, to copy the currently selected object, group or layer to the clipboard.
Equivalent to Edit>Copy or Ctrl+c.

● Paste icon, to insert the current content of the clipboard to the currently selected object,
group, layer or text. This function is only possible if the item on the clipboard is of a type that
can be inserted at the selected location. For instance, if the object on the clipboard is a text
object, and the selected object in the scenegraph is a Geo container then the Paste icon is
disabled.

● Preview icon, to start an external video device and show a preview of the scene. This is
useful for judging the representation of colors on TV.

● Alpha Modulation Editor to switch on or off the display of the Alpha Modulation Editor
which enables you to manually modify the alpha layer of a texture.

● Message log icon, to switch on or off the display of the Message log window, which
displays messages from the Weather Designer GUI or from the system.

● Geo browser icon, to switch on or off the display of the Geo Browser dialog, which
enables you to select and set weather stations and their coordinates for meteo objects.

● Render icon, to start the rendering of the scene. Equivalent to File>Render Now, that is,
the settings are taken from the page Rendering of the scenes object inspector.

● Render Manager icon, to submit the document to the watchfolder of the optional Render
Manager software.

Scene Graph / Object hierarchy

The scene graph allows you to structure the objects within the document. It offers three different
views, which between which you can choose by pressing the according tab.

Hierarchy
When the Hierarchy tab is pressed, the scene graph shows a hierarchical representation of the
content of the current document. It shows all objects of the scene in a tree-like arrangement which
allows you to:
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● select objects
● change the hierarchical position of an object
● rename objects
● copy and paste objects

Filter
The Filter allows you to view only objects of a certain kind. This feature is especially useful for
documents with many objects and a very complex view in the Hierarchy tab.

The Filter offers you the following options:

● Show objects of type: select the type of object you want to view.
● ...that are below: Checking this radio button, only objects that are below current selection or

a selected node (Select a node) will be displayed.
o current selection (only available if “...that are below” is selected): Only objects below

the object selected in the Hierarchy tab will be shown.
o Select a node (only available if “...that are below” is selected): Opens a new window

in which you can select objects below which node of the Hierarchy view will be
displayed.

● ...and are visible: If this radio button is selected, only objects that are visible will be
presented.

● ...and are unlocked: If this radio button is selected, only objects that are unlocked will be
shown.

Furthermore, the Filter View offers multiple selection, i.e. several objects can be selected at the same
time.

Task List
Tasks are managed in the Task List. They are useful, when Tasks have to be done repeatedly. This
helps i.e. a meteorologist to edit and configure maps, where the same steps have to be done every
day. The big advantage is to have a clear guide. It also prevents to make a direct modification of
settings in the hierarchy view.

Time Navigation Panel

The time navigation panel consists of the animation control buttons, which allow you to navigate
through the frames of an animation (Play, Stop, Forward, Backward, etc.)

▪ First frame button

▪ Backward 1 frame button

▪ Play/Stop button states animation is not running/ is running

▪ Forward 1 frame button
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▪ Last frame button

When the key symbol is pressed (red key ) the behavior of the navigation is different

▪ Jump to the first keyframe of a selected property

▪ Jump to the previous keyframe of a selected property

▪ Jump to the next keyframe of a selected property

▪ Jump to the last keyframe of a selected property

The animation timeline, which shows the time in seconds and in keyframe view the number of the
frame currently displayed. If you click with the right mouse button on the timeline, you can toggle
between Overview (only seconds) and Keyframe view (seconds and frames). Overview always shows
the whole animation regardless of its overall duration but does not allow you to manipulate
keyframes. In keyframe view, you can manipulate keyframes and the timeline shows only 10 seconds
at a time, which are normally 250 frames (depends on the settings Animation in the General page of
the scene).

Animation Control Panel

The animation control tab allows you to define and manipulate keyframes, that is, frames for which
you can define the features of the scene.

Status Bar

The Status bar displays context sensitive information about the use of the mouse in the viewport. It is
only active if the mouse pointer is located in the viewport.

Resource Manager

The lower windowpane offers different resource managers that can be accessed by pressing the
corresponding tab. When dragging an item from a Resource Manager to the object inspector the
desired property page can be selected by hovering over the corresponding tab.

The Texture Manager helps you to organize the textures you want to use in the document and
allows you to set the texture properties that are object independent (global).

Named colors are created and managed in the Color Manager.

All materials in the document are displayed and managed in the Material Manager.

The management of all data used for scalar fields is centralized in the Data Manager.

The Background maps Manager lists all Background maps, which are available in the
corresponding resource directory of the design model.
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The Geo image Manager lists all geo images, which are available in the corresponding resource
directory of the design model.

The External subscene Manager lists all subscenes, which are available. in the corresponding
resource directory of the design model. Drag & drop into to the viewport and into the input field for
the subscene file name is supported.

The Custom objects Manager lists all custom objects, which are available. in the directory
'.\CustomObjs' of the design model.

Often, template objects are just too different from what is wanted to visualize and external subscenes
are not flexible enough to achieve the desired result. This is especially critical for daily production
workflow where time is short.

Custom objects may be single objects, groups or even whole layers previously exported as XML file
and placed in the CustomObjs subdirectory of the design model folder (or subfolders thereof).
Examples for custom objects include different composite frontal systems corresponding to certain
meteorological standard conditions or preconfigured scalar fields showing specific data (e.g ECMWF
ppp). When you import a custom object any parameters it originally refered to will be recovered and
added to the parameter list of the scene.

All custom objects can and should be supplemented with a preview image. This image will be
displayed as thumbnail in the Custom objects Manager. Custom objects having a preview thumbnail
will be readily identifiable by the user and may serve as content building blocks easily added to the
document by drag and drop.

Object Inspector

In the object inspector you can explicitly change the values for an object’s properties. Depending on
the kind of object that is selected, there are different property pages in the object inspector.

Message Log

By default the Message log tab opens when you start Weather Designer. In this all message are
listed which are classified by an icon in the column Type. The message icons indicate the
significance of the message.

There are the following categories:

▪ Information icon signifies minor errors, for example, XML version conflicts. This kind
of errors are remedied automatically by the program by using defaults

▪ Progress icon signifies Weather Designer is processing data, loading elements, etc…

▪ Weather Designer icon indicates a faulty operation of the Weather Designer user
interface, for instance, if you try to create a Geo Object without a Geo Container.
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▪ Windows Icon announces a windows/system message, for instance, if you want to
close a document without having saved it before.

▪ Warning Icon indicates a faulty operation of the Weather Designer user interface, for
instance, if you want to input values outside the permitted range or with the wrong format into
a property field.

▪ Question Icon announces a question, for example, you may be asked whether you
want to load an autosaved document.

▪ Error Icon signifies an error, for instance, the failure to save a file (normally because
of an external reason).
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(Un)docking of windows
The Scene Graph, the Object Inspector and the Animation/Resource Manager windowpane can be
undocked and freely moved over the whole Windows desktop. By right clicking in the bottom of one
of these window panes, a context menu is displayed, where Undock can be chosen. It can be
re-docked by right clicking in the bottom of one of these window panes, a context menu is
displayed, where Dock can be chosen. By left clicking on the title bar of one of these windows one
can roll up the window. It can be rolled down by left clicking in the title bar again. The layout of the
windows is saved for every user and are restored at the next start of Weather Designer.
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